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Display File Extensions For All File Types (Win XP) 
 
A default installation of Windows XP displays all common files   in Windows Explorer 
and My Computer without file extensions.   However, if you would still like to see the 
file extensions, you can customize the operating system to display them.     
 
Open My Computer and then choose Tools | Folder Options. Select the View tab, locate 
the Hide Extensions For Known File Types check box, and deselect this option. Then, 
click OK to close all open dialog boxes. 
TOP!
 
The Only Way To Disable Searching In ZIP Files! 
 
The only way to disable searching in ZIP files is to turn off Win XP's support for treating 
ZIP files as folders. This is easy to do—and to undo. 
 
From the Start menu's Run dialog, enter this command: regsvr32 /u zipfldr.dll. Repeat 
and enter regsvr32 /u cabview.dll. Each time, you should get a notice that DllUnregister 
succeeded. Contrary to numerous Web sites displaying this advice, you need to restart the 
computer for the change to take effect. 
 
Now, when you search, the operating system will ignore ZIP folders instead of treating 
them as folders. If you don't care about that feature, you can leave it turned off. But 
turning it back on is as simple as repeating the two regsvr32 commands without the /u. 
TOP!
 
Share Files, Stay Safe In Windows XP! 
 
Enabling the Internet Connection Firewall will block other computers from viewing 
shared folders on your system. Here's how to enable file sharing with others on the LAN 
without disabling ICF. You should do this, of course, only if you trust others on your 
network. First, as noted above, be certain that you're behind a router that blocks 
unsolicited inbound traffic. Next, make sure you've locked down permissions so that only 
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the necessary folders are shared and they require user names and passwords for access. 
Now, go to your ICF and poke some holes in it: Right-click on your network connection 
and select Properties, then Advanced. Press the Settings button, then repeat the following 
process six times, replacing portnumber first with 135, then 136, 137, 138, 139, and 445. 
 
Click on the Add button and enter the following: 
 
•Description of Service: File Sharing portnumber 
 
•Name or IP Address: 127.0.0.1 
 
•External Port Number for This Service: portnumber 
 
•Internal Port Number for This Service: portnumber 
 
Click on OK twice. 
 
Now that you've opened these six ports for TCP traffic, you also need to do it for UDP 
traffic. Repeat the procedure above for the same six ports, this time selecting the UDP 
radio button under Select the external port for this service. 
 
Now, try browsing to one of the shared directories from another PC on your network. It 
should request your credentials and then work properly. But remember, you're relying on 
your hardware router/firewall to prevent anyone on the Internet from viewing your shared 
folders. 
TOP!
 
Map Drives In Windows XP! 
 
If you're using Windows file sharing, you probably know that you can access files on 
other machines not just by browsing your Network Places but by entering UNC 
(Universal [or Uniform] Naming Convention) names like this: 
 
\\machinename\sharename\path\to\file.txt 
 
But UNC names can become cumbersome. Instead, map a network location to a drive 
letter: Replace the UNC name above with something like P:\to\file.txt, where P: refers to 
a directory on another machine. 
 
Windows offers a number of ways to map network drives. From a command prompt (or a 
batch file invoked at start-up), you can type, using the example above, NET USE P: 
\\machinename\sharename\path. You can also go to Start | My Network Places, right-
click, choose Map Network Drive, and browse to a location. Or click on the Tools menu 
in the standard Windows toolbar and select Map Network Drive. 
TOP!

Copyright © 1999-2006 Internet Fixes. All rights reserved.
 

Legal Disclaimer        



Fifty Tips For Windows XP User’s New and Old! 
Sixth Edition! 

All products mentioned are registered trademarks or trademarks of their respective companies. 
Questions or problems regarding this web site should be directed to the Webmaster.

 
Creating A Workgroup Or Domain In XP! 
 
Although it's a cinch to set up file-sharing and access to PCs on a small network running 
Windows XP, you can go a step further and create a workgroup if you have more than a 
couple machines. Most commonly in a home environment you'd just create a workgroup, 
but if your network is more complex and you have a centralized multimedia server 
running Windows 2000 Server or Windows Server 2003, you'll want to set up a domain. 
 
In a workgroup scenario, each system has its own user database, and the local User 
Databases are responsible for validating users. When users need to access data on other 
systems, their user name and passwords must be defined on all those systems. 
 
Setting up a workgroup is easy. In Windows XP, right-click on My Computer, select 
System Properties| Computer Name | Change, and enter the appropriate computer name 
and workgroup (in Windows 2000, within System Properties you'll choose Network 
Identification and then click Properties to provide a workgroup name). Make sure that 
every computer on your home network references the same workgroup, in order to grant 
access to all other workgroup machines. 
 
Setting up a domain environment is more complex, but with it there is only one user 
database residing on the domain server. The domain server validates all users on the 
network and grants the appropriate permissions. Although a domain setup is more 
common in larger organizations, it has advantages even for smaller networks. 
 
With centralized user management you can more easily control access across all the PCs 
on your network. If, for example, you have a user name assigned for the tablet PC in the 
kitchen that has no access rights to any shares on the network, you don't have to worry 
that party guests will snoop around in your private files. Since it is significantly more 
complex to set up, however, we recommend that you consult Internet Fixes 
(www.internetfixes.com)and read about configuring a domain controller. 
TOP!
 
Running CHKDSK In Windows XP! 
 
One way to run a chkdsk (this is like Scandisk that was with Win9X), is to 
 
1. Double click on My Computer  
2. Right click on the drive you want to check  
3. Select Properties  
4. Click on the Tools tab  
5. Click on the Check Now button  
6. Check to Automatically fix file system errors - This is the same as running chkdsk /f  
7. If you want to Scan for and attempt recovery of bad sectors, check that box - This is 
the same as running chkdsk /R. It can also add a lot of time to the scan  
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8. Reboot if necessary  
You can also run chkdsk from the command line with will give you more options. 
 
The following switches are available: 
/F - fix any errors 
/R - identifies bad sectors 
/V - with FAT32, displays a verbose output 
With NTFS Volumes: 
/I - Performs simpler check (stage 2) 
/C - Skips the checking of cycles within folder structures 
/X - Forces the volume to dismount if necessary.  Intended for server administrators and 
should be avoided for normal use. 
TOP!
 
Additional Utilities On The Windows XP Pro CD! 
 
On the XP CD in the \Support\Tools directory, there are a lot of additional support and 
troubleshooting utilities.  You can run SETUP from that directory to install them. 
 
Just a few are: 
diruse                    Shows Disk Usage 
dupfinder        Finds Duplicate files 
getmac                    Get's MAC address of the network card 
hostname  Shows the host name of the computer 
netdiag                    Diagnoses a variety of network components 
pviewer  Show a list of process and allows you to get a memory detail or kill 
any process 
windiff                    Compare files and directories 
TOP!
 
Viewing Your IP Address Information In Windows XP! 
 
There are several ways you can determine your IP address information: 
 
IPCONFIG 
1. Start / Run / cmd  
2. IPCONFIG /ALL  
This opens a command window. One advantage is that you can send the information to a 
text file (IPCONFIG /ALL > c:\ip.txt) 
But sometimes the window shows show much information you need to scroll around to 
fine it. 
 
VIEW STATUS 
1. Control Panel / Network Connections / Double click the icons for your network (If the 
network has an icon in the system tray you can also just double click on that icon)  
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2. Click on the Support tab.  
3. Click on the Details button. 
TOP!
 
Changing The User Type In Windows XP! 
 
Normally in XP Pro, through the Control Panel / User Accounts icon, you are only 
allowed to create administrators or limited users. 
If you want to create others! 
 
1. Right click on My Computer  
2. Manage  
3. Local Users and Groups  
4. Users  
5. Right click on the user you want to change  
6. Properties  
7. Member of tab  
8. Add button  
9. Advanced button  
10. Find Now button  
11. From here you see the full list of possibilities (e.g. Power User, Backup Operator etc.) 
TOP!
 
Identify Faulty Device Drivers XP Pro Only! 
 
If you are having problems with lockups, blue screens, or can only get to safe mode, 
often the problem is due to a faulty device driver. 
 
One way to help identify them is through the use of the Verfier program: 
1. Start / Run / Verifier  
2. Keep the default of Create Standard Settings  
3. Select the type of drivers you want to confirm  
4. A list of drivers to be verified on the next boot will be shown.  
5. Reboot  
6. If your computer stops with a blue screen, you should get an error message with the 
problem driver  
7. To turn off the Verifier, run verifier /reset  
  
Find out more at: 
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q286568#appliesto 
TOP!
 
Opening Ports Or Adding Allowed Programs With SP2's Firewall! 
 
1. Click on Start / Run  
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2. Enter in firewall.cpl  
3. Click on the Exceptions tab  
 
Adding a Port for Internet Access: 
1. Click on the Add Port button  
2. Name it whatever you want  
3. Enter in the ports you want to open  
 
Adding a Program for Internet Access 
1. Click on Add Program... button  
2. A list of all installed programs will be displayed  
3. Highlight the one you want to include for Internet access  
4. Click on the OK button 
TOP!
 
Common Control Panel Applets In Windows XP! 
 
The follow are some common Control Panel Applets that are located in the 
\windows\system32 directory. 
 
If you find yourself using any of these frequently, then you can simply make shortcuts to 
them on your desktop. 
 
appwiz.cpl   Add/Remove Programs  
desk.cpl   Display Properties  
firewall.cpl   Firewall Settings  
inetcpl.cpl   Internet Options 
mmsys.cpl   Sound and Audio  
ncpa.cpl   Network Connections  
nusrmgr.cpl   User Accounts  
powercfg.cpl   Power Options  
sysdm.cpl   System Properties  
wscui.cpl   Security Center  
wuaucpl.cpl   Automatic Updates Configuration 
TOP!
 
Guest Only Network Access In Windows XP! 
 
If you try and connect to an XP computer and are shown a logins screen with only the 
computername/Guest, 
 
You may need to change one of the Local Security Policies: 
1. Got to Control Panel - Administrative Tools  
2. Go to Local Policies - Security Options  
3. Check the Network access: Sharing and security model for local accounts  
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4. Set it to Classic - local users authenticate as themselves 
TOP!
 
Not Displaying Previous Network Share Shortcuts In Windows XP! 
 
By default, when you go to Network Places, it will scan and show shortcuts to previous 
network shares. 
To turn this off and remove any current shortcuts: 
1. Open up the Windows Explorer  
2. Go to Tools / Folder Options / View  
3. The top section should be Files and Folders  
4. Uncheck Automatically search for network folders and printers  
5. Then go into Network Neighborhood and Select all the previous network connections 
Delete them  
6. Next time you look at the Network Neighborhood, they should not repopulate. 
TOP!
 
Easy Way To Share Multiple Folders In Windows XP! 
 
If you need to share multiple folders, running the program SHRPUBW.EXE  will bring 
up a simple dialog box to let you: 
 
1. Browse to the folder you want to share  
2. Enter in a Share name  
3. Ender in a Share description  
4. Set permissions. Several choices are available  
5. Restart the process from within the same program 
TOP!
 
Running Network Diagnostics In Windows XP Pro! 
 
Network Diagnostics scans your system to gather information about your hardware, 
software, and network connections.  
 
Click on Start / Run / NETSH DIAG GUI 
The following is the type of information that can be displayed: 
• Ping  
• Connect  
• Show  
• Verbose  
• Save to Desktop  
• Mail Service  
• News Service  
• Internet Proxy Server  
• Computer Information  
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• Operating System  
• Windows Version  
• Modems  
• Network Clients  
• Network Adapters  
• Domain Name System (DNS)  
• Dynamic Host Configuration Protocol (DHCP)  
• Default Gateways  
• Internet Protocol Address  
• Windows Internet Naming Service (WINS) 
TOP!
 
Configure for Auto-Logon In Windows XP! 
 
If you are the only person using the computer and want to have it automatically log you 
on: 
 
1. Start / Run / "control userpasswords2" - no quotes  
2. Uncheck User must enter a user name and password to use this computer. 
TOP!
 
Some Services You Can Disable In Windows XP Pro! 
 
There are quite a few services you can disable from starting automatically.  
This would be to speed up your boot time and free resources. 
They are only suggestions so I suggest you read the description of each one when you run 
Services and that you turn them off one at a time. 
 
Some possibilities are: 
• Alerter - Sends alert messages to specified users that are connected to the server 
computer.  
• Application Management - Allows software to tap directly into the Add/Remove 
Programs feature via the Windows Installer technology.  
• Background Intelligent Transfer Service - The Background Intelligent Transfer service 
is used by programs (such as Windows AutoUpdate) to download files by using spare 
bandwidth.  
• Clipbook - ClipBook permits you to cut and paste text and graphics over the network.  
• Error Reporting Service - Allows applications to send error reports to Microsoft in the 
event of an application fault.  
• Fast User Switching - Windows XP allows users to switch quickly between accounts, 
without requiring them to log off.  
• Help and Support - Allows the XP Built-in Help and Support Center to run.  
• IMAPI CD-Burning COM Service - You don't need this if you have other software to 
create CDs.  
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• Indexing Service - Indexes contents and properties of files on local and remote 
computers; provides rapid access to files through flexible querying language.  
• IP SEC - Manages IP security policy and starts the ISAKMP/Oakley (IKE) and the IP 
security driver. If you are not on a domain, you likely don't need this running.  
• Messenger - Transmits net send and Alerter service messages between clients and 
servers. This is how a lot of pop-up windows start appearing on your desktop.  
• Net Logon - Supports pass-through authentication of account logon events for 
computers in a domain. If you are not on a domain, you don't need this running  
• Network DDE - Provides network transport and security for Dynamic Data Exchange 
(DDE) for programs running on the same computer or on different computers.  
• NT LM Security Support Provider - Provides security to remote procedure call (RPC) 
programs that use transports other than named pipes.  
• Performance Logs and Alerts - Collects performance data from local or remote 
computers based on preconfigured schedule parameters, then writes the data to a log or 
triggers an alert. If you don't need to monitor your performance logs, then you don't need 
this service.  
• Portable Media Serial Number - Retrieves the serial number of any portable music 
player connected to your computer  
• QOS RSVP - Provides network signaling and local traffic control setup functionality for 
QoS-aware programs and control applets.  
• Remote Desktop Help Session Manager - Manages and controls Remote Assistance. If 
you are not using Remote Desktop you don't need this service.  
• Remote Registry - Enables remote users to modify registry settings on this computer.  
• Routing & Remote Access - Offers routing services to businesses in local area and wide 
area network environments. Allows dial-in access.  
• Secondary Login - Enables starting processes under alternate credentials. This is what 
allows you to run an application as another user.  
• Smart Card - Manages access to smart cards read by this computer.  
• Smart Card Helper - Enables support for legacy non-plug and play smart-card readers 
used by this computer.  
• SSDP Discovery Service - Enables discovery of UPnP devices on your home network.  
• TCP/IP NetBIOS Helper - Enables support for NetBIOS over TCP/IP (NetBT) service 
and NetBIOS name resolution. This should not be needed in today's network 
environment.  
• Telnet - Enables a remote user to log on to this computer and run programs, and 
supports various TCP/IP Telnet clients.  
• Uninterruptible Power Supply Service - Manages an uninterruptible power supply 
(UPS) connected to the computer.  
• Universal Plug and Play Device Host - Provides support to host Universal Plug and Play 
devices  
• Upload Manager - Manages synchronous and asynchronous file transfers between 
clients and servers on the network.  
• Volume Shadow Copy Service - Manages and implements Volume Shadow Copies 
used for backup and other purposes.  
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• Web Client - Enables Windows-based programs to create, access, and modify non-local 
files across the Internet.  
• Wireless Zero Configuration - Provides automatic configuration for the 802.11 adapters  
• WMI Performance Adapter - Provides performance library information from WMI 
HiPerf providers. 
TOP!
 
Stopping The Windows XP Messenger Service! 
 
To remove the ability for anyone in the world to pop up messages on your computer, you 
can disable the Messenger service.  
 
1. Click Start->Settings ->Control Panel  
2. Click Performance and Maintenance  
3. Click Administrative Tools  
4. Double click Services  
5. Scroll down and highlight "Messenger"  
6. Right-click the highlighted line and choose Properties  
7. Click the STOP button  
8. Select Disable or Manual in the Startup Type scroll bar Click OK 
TOP!
 
Cleaning the Prefetch Directory In Windows XP! 
 
Windows XP has a feature called Prefetch. This keeps a shortcut to recently used 
programs.  
 
However it can fill up with old and obsolete programs. 
 
To clean this periodically go to: 
1. Star / Run / Prefetch  
2. Press Ctrl-A to highlight all the files  
3. Delete them 
TOP!
 
Accessing Non-Listed Display Configurations In Windows XP! 
 
If you want to access display configurations not normally listed (e.g. 256 colors) 
1. In the Display Properties dialog box, click the Settings tab.  
2. Click the Advanced button.  
3. Click the Adapter tab,  
4. Click the List all modes button.  
5. Select the resolution, color depth, and refresh rate that you want and click OK. 
TOP!
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Doing A Repair Install In Windows XP! 
 
If XP is corrupted to the point where none of the previous solutions get it to boot, 
you can do a Repair Install that might work as well as keep the current settings.  
Make sure you have your valid Windows XP key. 
The whole process takes about half an hour depending on your computer. 
 
If you are being prompted for the administrator's password, you need to choose the 2nd 
repair option, not the first. 
1. Insert and boot from your Windows XP CD  
2. At the second R=Repair option, press the R key  
3. This will start the repair  
4. Press F8 for I Agree at the Licensing Agreement  
5. Press R when the directory where Windows XP is installed is shown. Typically this is 
C:\WINDOWS  
6. It will then check the C: drive and start copying files  
7. It will automatically reboot when needed. Keep the CD in the drive.  
8. You will then see the graphic part of the repair that is like during a normal install of 
XP (Collecting Information, Dynamic Update, Preparing Installation, Installing 
Windows, Finalizing Installation)  
9. When prompted, click on the Next button  
10. When prompted, enter your XP key  
11. Normally you will want to keep the same Workgroup or Domain name  
12. The computer will reboot  
13. Then you will have the same screens as a normal XP Install  
14. Activate if you want (usually a good idea)  
15. Register if you want (but not necessary)  
16. Finish  
17. At this point you should be able to log in with any existing accounts. 
TOP!
 
Hiding The Last User Logged On In Windows XP! 
 
If you use the standard NT style of login and want to hide the last user: 
1. Start the Group Policy Editor (gpedit.msc)  
2. Go to Computer Configuration / Windows Settings / Security Settings / Local Policies 
/ Security Options  
3. Scroll down to Interactive logon: Do not display last user name  
4. Set it to Enable 
TOP!
 
Stop Password Expiration In Windows XP! 
 
If you are getting an error message that your password is about to expire: 
1. Right click on the My Computer icon  
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2. Select Manage  
3. Go to Local Users and Groups / Users  
4. Right-click on the user you want to change  
5. Select Properties  
6. On the General tab, check Password never expires  
7. Click OK  
 
If you want to do this for all users, enter: 
Start / Run / net accounts /maxpwage:unlimited 
TOP!
 
Adding Environment Variables In Windows XP! 
 
Since any version of NT does not use an autoexec.bat file, 
to add environment variables to Windows XP: 
1. Right click on My Computer  
2. Select Properties  
3. Click on the Advanced tab  
4. Click on the Environment Variables button  
5. From here you can change it for the system or just the current user. 
TOP!
 
Removing Thumbs.db Files In Windows XP! 
 
When viewing a folder with the Thumbnail view, Windows XP creates a thumbs.db file. 
 
This is a cache of the current pictures in that directory. 
If you want to turn this feature off and save a little disk space 
1. Start the Windows Explorer  
2. Go to Tools / Folder Options / View  
3. In the first section under Files and Folders, check Do not cache thumbnails  
4. Now you can search for the thumbs.db file on your computer and remove them. No 
more should be created. 
TOP!
 
Controlling The Desktop Cleanup Wizard In Windows XP! 
 
By default, the Desktop Cleanup Wizard will pop up every 60 days to cleanup your 
desktop. 
To stop this: 
1. Right click on the desktop.  
2. Select Properties  
3. Click on the Desktop tab  
4. Click on the Customize Desktop button  
5. Uncheck Run Desktop Cleanup Wizard 
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TOP!
 
Clearing The Page File On Shutdown In Windows XP! 
 
Another way to set the computer to clear the pagefile without directly editing the registry 
is: 
1. Click on the Start button  
2. Go to the Control Panel  
3. Administrative Tools  
4. Local Security Policy  
5. Local Policies  
6. Click on Security Options  
7. Right hand menu - right click on "Shutdown: Clear Virtual Memory Pagefile"  
8. Select "Enable"  
9. Reboot 
TOP!
 
Re-Installing Windows XP! 
 
If you need to reinstall Windows XP and want to keep all your current installed 
applications and settings: 
1. Start Windows XP  
2. Go to the location of your source files  
3. Run WINNT32 /unattend  
 
I've often need to do this to repair something that had gotten corrupted and didn't want to 
do a clean install. 
TOP!
 
Speeding The Startup Of Some CD Burner Programs In XP! 
 
If you use program other than the native Windows XP CD Burner software,  
you might be able to increase the speed that it loads. 
1. Go to Control Panel / Administrative Tools / Services  
2. Double-click on IMAPI CD-Burning COM Service  
3. For the Startup Type, select Disabled  
4. Click on the OK button and then close the Services window  
5. You should notice an increase the speed. 
TOP!
 
No To All When Overwriting Files In Windows XP! 
 
When overwriting files in the Windows Explorer, there is an option for Yes To All. 
This would overwrite any files you would normally be prompted for. 
To have No To All, simply hold down the Shift key while you click on the No option. 
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TOP!
 
Re-Installing User Login Pictures In Windows XP! 
 
Normally Windows XP shows assigned pictures for each user on the system. 
If you have deleted your user pictures, want to know the location, or need to reinstall 
them, they are stored in the C:\Documents and Settings\All Users\Application 
Data\Microsoft\User Account Pictures\Default Pictures directory. 
If you need to reinstall them, they can be expanded from the source CD. The actual files 
are: 
airplane.bmp 
astronaut.bmp 
ball.bmp 
butterfly.bmp 
cat.bmp 
fish.bmp 
pink flower.bmp 
guitar.bmp 
snowflake.bmp 
beach.bmp 
car.bmp 
chess.bmp 
dirt bike.bmp 
dog.bmp 
drip.bmp 
duck.bmp 
frog.bmp 
horses.bmp 
kick.bmp 
lift-off.bmp 
palm tree.bmp 
red flower.bmp 
skater.bmp 
TOP!
 
Search Companion Error In Windows XP! 
 
When doing a file search, if you get the error A File That Is Required to Run Search 
Companion Cannot Be Found 
1. Log on as an Administrator  
2. Click Start  
3. Select Run  
4. Enter in the command - %systemroot%\inf  
5. Right-click the Srchasst.inf file  
6. Click Install 
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TOP!
 
Allowing Network Access With Blank Passwords In Windows XP! 
 
Although you can log in locally without a password, by default, Windows XP Pro does 
not allow network users to access the computer without a password. Typically you will 
receive an Unknown error 31 if this is the case. 
To change this setting: 
1. Run gpedit.msc  
2. Go to Computer Configuration / Windows Settings / Security Settings / Local Policies 
/ Security Options  
3. Double click on Accounts: Limit local account use of blank passwords to console login 
only  
4. Disable this option 
TOP!
 
Changing The Default DOS Window Properties! 
 
If you want to change the default DOS windows properties like: 
• Size  
• Color  
• Font  
• Buffer Size  
• Window / Full Screen  
 
1. Open up a DOS window  
2. Right click on the Title Bar  
3. Select Defaults  
4. Make any of the changes you like  
5. All subsequent DOS windows will assume these defaults. 
TOP!
 
Creating a Boot Floppy Within Windows XP! 
 
To create a bootable floppy from within Windows XP: 
1. Insert a floppy into the A: drive  
2. Open the Explorer  
3. Right click on the A: Drive  
4. Select Format  
5. Check Create an MS-DOS startup disk  
6. Click on the Start button  
7. This will create a Millennium boot disk 
TOP!
 
Re-Enabling System Restore In Windows XP Pro! 
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If you previously disabled system restore through the Group Policy Editor, 
the option to start it again does not show in the System Properties. 
You can re-enable it again by: 
1. Run the Group Policy Editor (gpedit.msc)  
2. Go to Computer Configuration / Administrative Templates / System / System Restore  
3. Set Turn off System Restore and Turn off Configuration to Disable  
4. Right click on My Computer  
5. Select Manage  
6. Go to Services and Applications / Services  
7. Scroll down to System Restore Service  
8. Set it for Automatic  
9. Click on the Start button to start the service  
10. Close down this window  
11. Go back to the Group Policy Editor and configure both to Not configured  
12. Now when you right click on My Computer, there should be a tab for System Restore 
and you can configure how much space will be used. 
TOP!
 
Rollback A Device Driver In Windows XP! 
 
If you install a device drive that does not work correctly, you can restore the previous one 
fairly easily. 
1. Log in with an administrator account  
2. Right click on My Computer  
3. Select Properties  
4. Click on the Hardware tab  
5. Click on the Device Manager button  
6. Go to the device you want to reconfigure  
7. Click on the Driver tab  
8. Click on the Roll Back Drive button 
TOP!
 
Selecting What Details To Display In The Explorer Window In XP! 
 
To add or remove items to be displayed in the Explorer when using the Details View. 
1. Start the Explorer  
2. Go to View / Choose Details  
3. Right click on the columns by Name and check or uncheck any item you want 
displayed  
Available options are: 
• Owner  
• Name  
• Size  
• Type  
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• Date Modified  
• Status  
• Attributes  
• Author  
• Title  
• Subject  
• Category  
• Pages  
• Comments  
• Copyright  
• Date Created  
• Date Accessed  
• Attributes  
• Artist  
• Album Title  
• Year  
• Track Number  
• Genre  
• Duration  
• Bit Rate  
• Protected  
• Camera Model  
• Date Picture Taken  
• Dimensions  
• Company  
• Description  
• File Version  
• Product Name  
• Product Version 
TOP!
 
Closing Multiple Taskbar Items In Windows XP! 
 
If you hold down the Control Key when you click on the taskbar icons, it selects multiple 
tasks. Then you can simply right-click on the selected items and choose close group.  
 
This tip works with all windows, not just one application. If you have the cal, ie, notepad 
and solitaire open, it will close them all, unlike the group similar items command that 
only lets you close all of one type (ex: all IE or all notepads). 
TOP!
 
Grouping Similar Taskbar Buttons In Windows XP! 
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When you open more than one document in the same program and then minimize each 
document, rather that showing separate icons on the taskbar for each document, Windows 
XP groups them under a single icon for that application.  
If you want to group, or ungroup, similar taskbar buttons, 
1. Right click on the Taskbar.  
2. Select Properties.  
3. Check or Uncheck Group similar taskbar buttons. 
TOP!
 
Turning Off The Guest Account In Windows XP! 
 
For security purposes, you might want to turn off the Guest account! 
1. Open up the Control Panel  
2. Click on User Accounts  
3. Click on Change an account  
4. Click on the Guest account  
5. Click Turn off the guest account 
TOP!
 
Turning Off the Built-In CD Burner Software In XP! 
 
If you want to turn off the ability to using the built-in CD burner software that comes 
with Windows XP: 
1. Open up the Explorer  
2. Right click on the drive that is your CD burner  
3. Select Properties  
4. Click on the Recording tab  
5. Uncheck Enable CD recording on this drive 
TOP!
 
Hiding System Tray Icons In Windows XP! 
 
With Windows XP, you can manually select how you want individual icons in the 
System Tray to be displayed. 
 
1. Right click on the Taskbar.  
2. Select Properties.  
3. Check Hide inactive icons.  
4. Click on the Customize button.  
5. This will bring up a dialog box that will allow you to select one of three options for 
your applications: 
Hide when inactive, Always hide, or Always show.  
6. Highlight current or past applications and make any changes you like.  
7. A small arrow will now appear in the System Tray that will allow you to show or hide 
these icons. 
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TOP!
 
Faster Task Switching In Windows XP! 
 
If you installed Windows XP Power Tools from Microsoft, when you press Alt-Tab to 
switch between running applications, you get a screen that shows a small graphic of the 
window that is of that application along with its icon. 
This also takes a long time to display. (Or at least longer than I'm comfortable with) 
You can speed this up and revert back to previous ways task switching is displayed. 
 
To Turn This Off After Your Reboot: 
1. Run MSCONFIG  
2. Click on the Startup tab  
3. Uncheck Taskswitch  
4. Click on the OK button  
5. If you want to keep working, click on Exit without Restart  
 
To Turn This Off Immediately: 
1. Press Ctrl-Alt-Delete  
2. Click on the Processes tab  
3. Highlight TaskSwitch.exe  
4. Click on the End Process tab  
5. Click on the Yes button 
TOP!
 
Windows XP Command Line Utilities! 
 
While there are a lot of command line utilities in Windows XP, here are some that I have 
been using lately. 
 
bootcfg - Configures, queries, or changes Boot.ini file settings. 
 
driverquery - Displays a list of all installed device drivers and their properties. 
 
getmac - Returns the media access control (MAC) address and list of network protocols 
associated with each address for all network cards in each computer. 
 
gpresult - Displays Group Policy settings and Resultant Set of Policy (RSOP) for a user 
or a computer. 
 
netsh - You can use commands in the Netsh Interface IP context to configure the TCP/IP 
protocol. 
 
schtasks - Schedules commands and programs to run periodically or at a specific time. 
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systeminfo - Displays detailed configuration information about a computer and its 
operating system. 
TOP!
 
Increasing Graphics Performance In Windows XP! 
 
By default, Windows XP turns on a lot of shadows, fades, slides, etc to menu items. 
Most simply slow down their display. 
 
To turn these off selectively: 
1. Right click on the My Computer icon  
2. Select Properties  
3. Click on the Advanced tab  
4. Under Performance, click on the Settings button  
5. To turn them all of, select Adjust for best performance  
6. My preference is to leave them all off except for Show shadows under mouse pointer 
and Show window contents while dragging. 
TOP!
 
Using The System File Checker In Windows XP! 
 
You can run the System File Checker to verify protected system files.  
 
Command line switches are: 
sfc [/scannow] [/scanonce] [/scanboot] [/revert] [/purgecache] [/cachesize=x]  
 
• /scannow  - Scans all protected system files immediately.  
 
• /scanonce - Scans all protected system files once.  
 
• /scanboot - Scans all protected system files every time the computer is restarted.  
 
• /revert - Returns the scan to its default operation.  
 
• /purgecache - Purges the Windows File Protection file cache and scans all protected 
system files immediately.  
 
• /cachesize=x - Sets the size, in MB, of the Windows File Protection file cache. 
TOP!
 
Speeding Up the Display of Start Menu Items! 
 
An easy way to speed up the display of the Start Menu Items is to turn off the menu 
shadow. 
1. Right click on an open area of the Desktop  
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2. Select Properties  
3. Click on the Appearance tab  
4. Click on the Effects button  
5. Uncheck Show shadows under menus 
TOP!
 
Setting System Time Over the Internet! 
 
You can set your system clock to a time server on the Internet. 
1. Double-click the time on your taskbar  
2. Click the Internet Time tab  
3. Check Automatically synchronize with an Internet time server  
4. Click on the Update Now button 
 
Note:  This does not work with all Internet Service Provider's! 
TOP!
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